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INTRODUCTION
	Mark Twain is often attributed to the saying “There are three kinds of lies:  lies, damned lies, and statistics.”  We are surrounded by numbers, percentages, and data every day.  As the COVID-19 pandemic swept across the globe, the news feeds provided daily numbers of cases with the intent to keep us informed.  Stock market traders rely on daily numbers to make decisions about the world’s financial situations.  Commercials show percentages of people who use or benefit from a particular product.  All of these numbers provide important information.  However, they usually don’t show the entire picture of the data set gathered.  As scientists, it is of utmost importance that we not only gather data, but we understand what this data represents.  By understanding the entire picture, much more meaningful information can be shared.  In his book Innumeracy John Allen Paulos provides an example of data misinterpretation.  A 1936 political poll in Literary Digest predicted Alf Landon would beat Franklin Roosevelt by a three to two margin.  However, this margin only represented twenty-three percent of the people polled who bothered to return the poll survey.  In addition, the 23% of respondents were wealthy constituents.  This small population certainly did not represent all voters because Roosevelt won the election.  When analyzing data it is important to consider how the data was collected, variables in the samples, sample size, and to calculate deviations within the sample set.
	This laboratory exercise is divided into two parts.  The first part consists of calculating statistical analysis with a given data set using Excel™.  For the second part of the experiment, students will gather their own data, and also use Excel™ to analyze the meaning of the data gathered.
MATERIALS
· Computer with Excel™ software
· Excel™ file with Penny Data provided by the instructor
· Fun size packages of M&Ms (enough for 3 bags per student)
· Analytical balance

BACKGROUND INFORMATION
	Why is it important to calculate the statistics of a data set?  All data is prone to error.  If humans are collecting the data, it is not likely that the data will show one hundred percent consistency.  Even if an instrument is collecting data, there are factors such as electrical or background noise that need to be removed from the data set.  
	Which statistical pieces of data should be calculated?  In this exercise, students will use Excel™ to calculate and graph the standard deviation, average, median, maximum data point, and minimum data point in a large data set.  Students will also learn to use the count and subset functions with Excel™.

	Average- The average is the sum of all of the measurements divided by the number of measurements.  The average of a repeated measurement helps to eliminate variability. 


	Standard Deviation- The standard deviation is a calculation that shows how close all of the measurements are to the average.  If the standard deviation is small, it shows the data was reproducible (precise).  However, even if the data is precise, it may not be accurate (close to the true value).
Standard Deviation = 

Median- The median is a number in the middle of the data set with an equal number of values above and below it.  This value is not necessarily the same as the average.  
For a sample with an odd set of data points, the median is the middle value.  For a sample with an even set of data points, the median is determined by adding the two middle data points and dividing by two.  For example, in a set of fourteen numbers, the median would be found by adding the seventh and eighth number in the data set and dividing those values by two.

Examples of calculations in a Data Set
	Student
	Exam 1
	Exam 2
	Exam 3
	Exam 4

	A
	95
	65
	75
	60

	B
	90
	88
	83
	91

	C
	65
	53
	70
	62


 




Student A’s exam average is calculated as follows:
Average = (95+65+75+60)/4 = 74
The standard deviation for student A’s exams is calculated as follows:
(95-74)2 + (65-74)2 + (75-74)2 + (60-74)2 = 719
 
 = 15

Median for all Student’s Exam 1 score = 90 

PART 1 OR PRE-LAB EXERCISE
	For this part of the lab experiment, students are given a data set including 500 pennies.  The date and mint location of each penny was recorded in an Excel™ spreadsheet.  Students should complete the following manipulations of the data:
1. Standard deviation, average, median, maximum, and minimum values for the mass of all the pennies in the data set
2. Standard deviation, average, median, maximum, and minimum values for the year of all the pennies in the data set
3. How many pennies were minted each year in the data set?
4. The composition of pennies changed after a certain time period.  What year did the composition change based on the masses in the data set?
5. Make a histogram of the number of pennies by year
6. Make a histogram of the average mass of pennies by year
7. Calculate the count of pennies in the data set after the composition change
8. Calculate how many masses fall within the standard deviation
9. Calculate how many pennies are made at the different mint locations

PRE-LAB EXERCISE QUESTIONS
1. For which year of pennies in the data set was the standard deviation the lowest?

2.  Did the standard deviation increase, decrease, or stay the same for the mass of pennies minted before and after the composition change?



3.  Which location minted the most pennies in this data set?
Introduction to Excel
A spreadsheet is defined as a document that contains data that has been arranged into rows and/or columns and can then be used in calculations to get information from or about that data.  Microsoft Excel and Google Sheets are two examples of spreadsheet software.  The following instructions are tailored to Microsoft Excel but should work just as well in Google Sheets.
Excel Basics
Download the file GettingStarted.xlsx from the class web site and open it with Excel.  The file contains a series of random numbers in column A; there is a label is cell A1 and the numbers are listed in cell A2 through A21.  This data will be used to introduce some basic information about Excel.
Sorting the Numbers
· Select the numbers by clicking on cell A2 and dragging the cursor down to cell A21 before releasing the mouse button.
· Select the Data tab and then click the Sort button. [image: ]
· Because there is only one column of data in this example, the sort box already has the range of cells selected.  Otherwise, the range of cells would need to be selected.
· Confirm that the sort order is set to Smallest to Largest.
· Click OK.
Get the Sum of the Numbers
Functions are tools that typically take some input (data) and return some output (results).  In this case, the SUM function takes our numbers as input and outputs the sum.  
· Select cell D1 and enter the text Total.
· Select cell E1 and enter the equation =SUM(A2:A21).
· Press Enter.
All equations in Excel begin with an equal sign (=) to let Excel know that it will perform a calculation.  As the name of a function is being typed, Excel will present the names of all of the functions that begin with those letters.  Once the opening parenthesis is typed, Excel provides a prompt with what inputs the function expects.  If additional help is needed with a function, click the [image: ] button to the left of the formula bar.
The SUM function takes a series of numbers or a range of cells as its input.  In this case, the range of cells containing the random numbers was used as the input.  A range of cells is defined by the upper-left cell in the range, a colon, and then the lower-right cell in the range.
Finding the Minimum Value
While it is easy to look at this small set of numbers and find the smallest and largest values, it may not be so easy with larger data sets so Excel provides the functions MIN and MAX.  Like the SUM function the MIN and MAX functions take a series of numbers or a range of cell as input.
· Select cell D2 and enter Minimum.
· Select cell E2 and enter =MIN(A2:A21).
· Press Enter.
Naming a Range
So far, the range of cells has had to be selected or entered as A2:A21 each time it has been used in a function.  Excel provides a mechanism to name a range and then refer to the range by that more descriptive name in functions.
· Select the range of cells with the random numbers.
· Select the Formulas tab and click the Name Manager button. [image: ]
· Click New.
· In the Name field, enter a descriptive name for the range.  In this case, use Numbers.
· Press OK.
It is important to know about the Name Manager tool as it allows for the modification of named ranges or the deletion of a name.  There is an alternative method to name a range of cells that is easier and quicker.
· Select the range of cells with the random numbers.
· Click in the Name Box to the left of the Formula Bar.
· Enter a descriptive name for the range.
· Press Enter.
Finding the Maximum Value
Rather than selecting the range of cells to use in the MAX function, the name for the range will be used.
· Select cell D3 and enter Maximum.
· Select cell E3 and enter =MAX(Numbers).
· Press Enter.


Analyzing Pennies:
Download the file Penny Data.xlsx from the course website and open it with Excel.  The spreadsheet contains information about five hundred pennies arranged into three columns with labels in the first row to describe what is in the column.  The first column contains the mass of each penny measured in grams.  The second column is the year the penny was minted.  The last column has a letter to designate where the penny was minted; ‘D’ means the penny was minted in Denver and ‘P’ means that it was minted in Philadelphia.
To get started, follow the instructions in the previous section and defines names for the ranges of cells that contain the masses, years, and mint information.  To make it easier to follow along with later instructions, use Mass, Year, and Mint as the names for the three ranges.
Because the data set for the 500 pennies is so large, we can’t look at all of it at one time.  Since we named the individual ranges there really is no need to see the data.  Excel (and Google Sheets) allow a workbook to contain multiple spreadsheets.
Renaming an Existing Spreadsheet
· Double click on the tab at the bottom left of the spreadsheet.  It should currently be labeled as Sheet1.
· Type in Data to change the label.
· Press Enter.
Adding a New Spreadsheet
· Click the plus sign to the right of the spreadsheet tab. [image: ]
· Follow the instructions above to change the label to Mass-Year-Mint Info.
Describing the Data
A set of data can be described by its maximum, minimum, and median values along with the average and standard deviation of the values.  The MAX and MIN functions were introduced earlier.  The MEDIAN function is used to find the middle or center-most value from a set.  Like the MAX and MIN functions, the MEDIAN function takes a series of numbers or range of cells as its input.
The AVERAGE function does exactly what its name suggests; it calculates the average value for a set of data.  The STDEV.P function returns the standard deviation for a population (complete set of data).  Both functions take a series of numbers or a range of cells as input.
· Select cell A1 in the Mass-Year-Mint Info spreadsheet.  Enter the label Mass Data.
· Create appropriate labels for maximum value, median value, minimum value, average and standard deviation in cells A2 through A6.
· Enter the appropriate equations into cells B2 through B6 to calculate the maximum value, median value, minimum value, average and standard deviation for the mass data.
Perform the same analysis for the years the pennies were minted (place the 
label in cell A9).
Because where the pennies were minted is not a numeric value maximum, minimum, median, average, and standard deviation do not make sense.  It is possible to determine how many pennies were minted in Denver and how many were minted in Philadelphia.  The COUNTIF function takes a series of number of a range of cells along with a criterium or test.  The function checks each value against the criterium and if the result is true the value is counted.  In this case we want to count only the mint marks that are equal to the letter D to find out how many pennies were minted in Denver.
· Select cell A16 and enter Mint Data.
· Select cell A17 and enter Denver.
· Select cell A18 and enter Philadelphia.
· Select cell B17 and enter =COUNTIF(MINT,”D”).
· Select cell B18 and enter the appropriate equation to determine the number of pennies minted in Philadelphia.
There should not be a difference in the mass of pennies minted in Denver and Philadelphia, but it is worth checking.  To determine the average mass of the pennies minted in Denver, the pennies minted in Denver need to be selected and the pennies minted in Philadelphia need to be skipped.  This can be done by embedding a function inside of another function.
· Select cell C17.
· Enter the equation =AVERAGE(IF(MINT=”D”,Mass)).  DO NOT PRESS ENTER.
· Press CTRL-SHIFT-ENTER.
The AVERAGE function determines the average of a series of numbers.  The embedded IF will return that series by checking the mint data in each record.  When the value is a capital D, it will return the mass data from that record.  When the value is not a capital D, it will skip that record.  Excel requires you to press CTRL-SHIFT-ENTER to execute these more complex equations.  Simply pressing Enter will result in an incorrect calculation.
· Enter the appropriate equation into cell C18 to calculate the average mass of the pennies minted in Philadelphia.
· Enter the appropriate equations into cell D17 and D18 to calculate the standard deviation of the mass for pennies minted in Denver or Philadelphia.
Analyzing the Mass of Pennies for each Year
It would be informative to determine how many pennies from our sample were minted each year and what the average mass is for each year.  Based on the earlier calculations, the oldest penny was minted in 1932 and the newest penny was minted in 2020.  For this analysis, the unique years will be extracted from the Year data rather than counting the number of pennies from each year starting in 1932 and ending in 2020.  This avoids the error that occurs when trying to calculate an average mass of pennies when no pennies from the sample was minted in that year.
· Select the Data tab and click the Advanced button. [image: ]
· Click the radio button for Copy to another location.
· Enter Year into the List Range field.
· Leave the Criteria range field blank.
· Enter E2 into the Copy to field.
· Check the box by Unique records only.
· Press OK.
Create a new spreadsheet in the workbook and label it Mass by Year Data.  Select the unique year values and cut (CTRL-X) them from the spreadsheet and paste (CTRL-V) them into the new spreadsheet starting in cell A2.  Make sure to give this list a descriptive label in cell A1.  Create headings for Number, Average Mass, and Standard Deviation in cells B1 through D1.
· Sort the years so that they are in increasing order.
· Use the COUNTIF function to determine how many pennies were minted each year.
· Use the AVERAGE and STDEV.P functions to determine the average and standard deviation of the masses of the pennies minted each year. 
Notice that a standard deviation cannot be determined when there was only one penny minted that year and Excel returns zero.
Generating a Chart of Number of Pennies vs Year
This new table of data is interesting but not terribly informative as presented.  It would be more informative if parts of it were presented in chart form.  
· Select cell H1.
· Select the Insert tab and click the column or bar chart icon.  [image: ]
· Select the first, 2D bar chart option.  [image: ]
· Right click anywhere inside the empty chart and click Select Data.
· Click Add above the lower-left window.
· Select the Series name field and click cell B1.  This is the title of the y-axis.
· Select the Series values field, delete the contents of the field, and then select cells B2 through B62.  These are the y-values for the chart.
· Click OK.
· Click Edit above the lower-right window and select the Year values from the table: A2 through A62. 
· Click OK.  
· Click OK in the Select Data Source prompt to generate the chart.
While the chart is nice, it is small and can be misplaced within a spreadsheet containing data.  It is usually best to move charts to their own tab (spreadsheet).
· Right click anywhere inside the chart.
· Select Move Chart.
· Click the New sheet radio button and provide the sheet with a descriptive label.
Generating a Chart of Average Mass of Pennies vs Year
· Use the process outlined above to generate a new chart of average mass of pennies vs year and move it to its own tab.
Is there anything curious about this chart?  What happened in 1982-83?
Describing the Data for Pennies minted after 1982
· Select the Mass-Year-Mint Stats tab.
· Create a new label in cell E1: Mass of Pennies Minted after 1982.
· Create appropriate labels for maximum value, median value, minimum value, average and standard deviation in cells E2 through E6.
· Enter =MAX(IF(Year>1982,Mass)) into cell F2 to find the maximum mass of the pennies minted after 1982.  Press CTRL-SHIFT-ENTER to execute the calculation.
· Enter appropriate equations into cells F3 through F6 to calculate the median value, minimum value, average and standard deviation.

PART 2-COLLECTING DATA WITH FUN SIZE PACKAGES OF M&Ms
1. Each student is provided with 3 fun size packages of plain M&Ms.
2. Students should record the Expiration date and lot number from the outer packaging that contained the Fun Sized bags.
3. Students should then weigh each M&M from their Fun Sized bags.  They should record expiration date, lot number, color, and mass into an Excel spreadsheet for each M&M.  It is important to use the correct number of significant figures when reporting the masses of the M&Ms.
4. Students should also record the data in a common spreadsheet provided by the instructor.  The instructor will compile the data and provide each student with a class data file. 
5. Students should calculate and graph the following for the data set
a. Average mass and standard deviation for all of the M&Ms in the class data set.
b. Average mass and standard deviation for the different colors of M&Ms in the class data set.
c. Average number and standard deviation for the number of M&Ms in a Fun Sized bag.
d. Average number and standard deviation for the number of red M&Ms in a Fun Sized bag.

POST LAB QUESTIONS

1. Which color of M&Ms had the lowest standard deviation in terms of mass?


2. How did the class data compare to your individual data in terms of average mass and standard deviation of the individual M&Ms?


3.  Which color appeared the most number of times in a fun size bag?
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